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Basic Computer Skills

By the end of this class, you will know how to:
create a new worksheet
use basic formulas
format a worksheet
use charts
save a workbook

Microsoft Excel
Microsoft Excel is a spreadsheet program. It is used to record and present numeric
information or data. It lays information out in a grid format, where each grid ‘cell’ has a
reference (like on a road map). This reference is the column letter and the row number
in a cell. You can enter text, numbers, or enter a formula into a cell.
1.
Open Excel
The Excel Window will open with a new workbook.

Excel Window
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Menu Bar
 access to standard features such as save, open, exit
 also contains many features which are unique to Excel - many of these can be
found under the Formulas and Data menus
Tool Bar
 contains buttons that perform many common functions you use in Excel - includes
formatting options and function options, etc.
Formula Bar
 used to view and edit the formulas entered in a cell
Worksheet
 the main area of the Excel window
 made up of a grid - each column is labelled with a letter and each row is labelled
with a number
 the intersecting points of each column and row are called cells
 each cell is referenced by its location in the grid, like a road map (see diagram
below)

Worksheet Tabs
 you can have more than one worksheet of data in your workbook
 the worksheets are represented by tabs at the bottom of the Excel window
 to move between worksheets, click on the worksheet tab you want to view
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Cells



if a cell is selected, it will have a bold border around it
when the cell is selected, you can type words or numbers to enter the data into
that cell

1.

Click on cell A1

2.

Type Monthly Expenses

3.

Press Enter on your keyboard

Adjusting Cell Width And Height
you can adjust the width of a column or the height of a row

We will widen row A so that Monthly Expenses fits across the cell.
1.
Move your mouse cursor over the line between the grey row A cell and the grey
row B cell at the top of your worksheet.
2.
When your cursor changes to a double headed arrow, click and hold down your
left mouse button
3.

Drag the column to the right so that Monthly Expenses fits within the cell

4.

Release the left mouse button

Moving Between Cells

There are a few ways you can move between cells on your spreadsheet:
use your mouse to click on another cell
press the arrow keys on your keyboard to move up, down and across cells
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press the Tab key on your keyboard to move one cell to the right
press the Enter key on your keyboard to move one cell down
press the Home key on your keyboard to go to the first column in the current row
press the Ctrl and Home keys on your keyboard to go to cell A1
1.
Use your mouse or keyboard to move around the cells of your worksheet
2.

Type this data into your cells:

3.

Widen the columns and rows to fit the data into the cells

Inserting Rows And Columns
To insert an extra row or column:
1.

Click on a cell. The new row or column will be inserted before your selected cell

2.

From the Home menu, select either Insert Sheet Rows or Insert Sheet Columns
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Formulas And The Formula Bar

The formula bar displays the formula of the selected cell and the cell displays the
answer.
When you click on a cell that has a formula, the cell will display the value.
The formula bar will display the formula used to get that value.
If you want to change the formula later on, you can click on the cell and then edit the
formula in the formula bar.

Using Basic Formulas
Entering A Formula In A Cell
You can perform mathematical calculations using data in other worksheets.
On our current worksheet, if we wanted to know how much gas and electricity cost in
January, we could use a calculator, enter 15 + 40 and find out it cost us 55 dollars.
An easy way to do calculations is by using Excel. Instead of saying 15 + 40, we can
replace the numbers with the cell reference of where we got that number from. In this
case, B4 + B5 gives us the total of 55.

6

Basic Computer Skills

If you are going to use formulas, you must tell Excel that what you are typing is a function,
and not words or numbers. To do this, you need to type an equals sign (=) before the
formula (equation).
1.
Type Gas and Electricity in cell A11
2.

Click on cell B11

3.

Type =B4+B5 and press the Enter key on your keyboard

4.

Your spreadsheet should look like this:

4.
Change the electricity value in cell B5 to 42. Note how this change is
automatically reflected in cell B11.

AutoSum
With AutoSum, you can select a range of cells and tell Excel to automatically ‘add up’ or
sum the total of those cells.
The AutoSum button is in the toolbar at the top of the window and has a ∑ symbol on it.
1.

Click on cell A9 and type Total

2.

Click on cell B9 and click on the AutoSum button
Excel will guess which cells you want the sum of by selecting them (you will see a
flashing border around them)
If these are the cells you wish to sum, press the Enter key on your keyboard
To select different cells, click and drag your mouse to select the cells to total, then
press the Enter key on your keyboard
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3.

Press Enter on your keyboard

4.

Your spreadsheet should look like this:

5.

Change the Gas value in cell B4 to 21. Notice how this change is automatically
reflected in cell B9 and cell B11.
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Using The Formula Bar To Create Formulas
We can also use the formula bar to help us create a formula.
1.

Select the cell you want to enter the formula in

2.

Click the fx button at the start of the formula bar

3.

The Insert Function window will open

4.

Select the function you want to use, and press OK

5.

Excel will give you the function variables. These are called arguments and they
are different for each different function type. Enter the arguments and press OK.
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Common Functions
Here are some common functions and examples of how they can be used with the
spreadsheet below.

SUM
Calculates the total of cells within a specified range
 a range is set in this format - first cell in range:last cell in range
For example, to get the total sales in March:
 select SUM as the function
 in the Function Arguments window, the Number 1 argument is D3:D6
 we are telling Excel to calculate the sum of cells D3, D4, D5 and D6
AVERAGE
Calculates the average value of the cells in the specified range (shown in column F)
For example, to get the average monthly sales for DVD players:
 select AVERAGE as the function
 in the Function Arguments window, the Number 1 argument is B5:E5
MAX
Gives you the highest number from a specified range (shown in column G)
For example, to get the highest monthly sales total for fridges:
 select MAX as the function
 in the Function Arguments window, the Number 1 argument is B3:E3
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MIN
gives you the lowest number from a specified range (shown in column H)
For example, to get the lowest monthly sales total for fridges:
select MIN as the function
in the Function Arguments window, the Number 1 argument is B3:E3
IF
IF is a logic operator
By defining a question, IF will provide one of two outcomes defined by the user
depending on whether the test is found to be true or false
For example, to see if we reached our sales target in January, and if we want the result
to be Yes or No:
in the Function Arguments window

Comparison Operators
=
Equal to
>
Greater Than
<
Less Than
>=
Greater than or equal to
<=
Less than or equal to
<>
Not equal to

The logical test can be broken into 2 parts:
1.
Excel to calculates the sum of B3 to B6.
2.
If the sum is greater than or equal to (>=) or equal to our target in cell B10, then
the result is true (yes). If the sum is less, then the result is false (no).
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1.

On your current worksheet, type Average in cell D3

2.

Select cell D4 and click on the function bar button (fx)

3.
Choose the Average function to find the average cost of gas for January and
February
4.

Your spreadsheet should look like this:

Copying Cells And Formulas
When you have a formula working, you may want to repeat it across many columns or
rows. Instead of re-entering it, you can copy the cells across or down. The formulas will
update automatically with the values in the row or column you have copied it to.
1.

Click on cell D4

2.

Move your mouse cursor over the black square in the bottom right corner of the
cell border. The cursor will turn into a + symbol

3.

Click and drag your mouse downwards to select cells D5, D6, D7 and D8

4.

When you release the mouse button, Excel will immediately copy and update the
formulas
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Auto Complete
Excel can automatically complete a list, such as days of the week and months.
1.
Click on the + button next to Sheet1 at the bottom of your workbook to create a
new worksheet
2.

Create this spreadsheet:

3.

Click on cell B3 to select Monday

4.
Move your mouse cursor over the black square in the bottom right corner of the
cell border. The cursor will turn into a + symbol
5.
Click and drag your mouse to the right to select cells B3 to H3. Release your
mouse button.
6.

Excel continues the sequence of day names to Sunday

Formatting Your Worksheet
Merging Cells
Sometimes, you may want the contents of one cell to span over several columns, such as
a title. You can do this by merging two or more cells together.
1.

Click and drag your mouse to select cells A1 to H1

2.

In the toolbar at the top of the window, click the Merge & Center button

3.

The selected cells will merge
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Numbers
You can change the way numbers are displayed in a cell using the Cell Format options.
There are 2 ways to do this.
The first and easiest way is to use the Cell Format options on the toolbar.

The second way gives you more options on how to format the contents of your cells.
1.

Select the cell(s) you want to format

2.

From the Format menu at the top of the screen, click on Format Cells

3.

The Format Cells window will open. Select the Number tab.

4.

Under Category is a list of the different types of formats you can use. When you
select a category, the options on the right will update to reflect the chosen
category.

5.

After you have made your selection, click OK to apply it to the cells you selected
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Font
You can change the font for one or more cells by either using the formatting options on
the toolbar or:
1.
Select the cells to change the font
2.
From the Home menu at the top of the screen, under Font, click the expand
button.

3.

The Format Cells window will open. Select the Font tab.

4.

Select the font options you want and click OK
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Borders
You can place borders around one or more cells to make the layout of your spreadsheet
clearer when it is printed.
To add a border to one or more cells:
1.
Select the cell(s) that you want to add the border to
2.
From the Home menu at the top of the screen, under Font, click the expand
button.

3.

The Format Cells window will open. Select the Border tab.

4.

Make your border changes and click OK

Cell Colour
You can change the colour of one or more cells, as well as the pattern that appears
inside the cell. This can be useful to block out cells on spreadsheets like rosters and
schedules.
To change a cell’s colour and pattern:
1.
Select the cell(s) you want to add the border to
2.
From the Home menu at the top of the screen, under Font, click the expand
button.
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3.

The Format Cells window will open. Select the Fill tab.

4.

Make your colour and pattern changes, then click OK

Wrap Text
Sometimes, you may want the contents of a cell to fit inside it, instead of spanning over
several columns. You can wrap the text, so that all of it stays inside one cell.
1.

Richt click on the cell

2.

Click Format Cells

3.

Click on the Alignment tab

4.

Click on the Wrap text tick box and click OK
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Activity
1.

Select Sheet 3 in your workbook and create this spreadsheet:

2.

Make the column headings bold and navy blue

3.

Place a border around all the cells used in the table

4.

Give Peter and Dave’s rows a coloured background

5.

Format the values in column F as a percentage value

6.

Format the values in column D as dollar values

7.

In cell E4, enter this formula to calculate the average sales figure: =D4/C4

8.

Copy the formula from cell E4 into cells E5, E6, and E7
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Managing Worksheets
You can have many worksheets in your workbook. These are accessed by using the tabs
at the bottom of the Excel window. To make the different sheets within your document
more distinguishable, you can change the display name and colour of your tabs, as well
as insert new worksheets, add new worksheets, and make copies of existing
worksheets.
Renaming Sheets
You can rename your worksheets so they do not have the default names “Sheet 1” and
“Sheet 2”. For example, if you were working on a budget for each month, you may wish to
name one sheet “January”, the next “February” and so on.
1.

Right click on the Sheet 1 tab at the bottom of the screen

2.

From the pop-up menu, click Rename

3.

Type Monthly Expenses and press Enter on the keyboard

4.

Rename Sheet 2 to Hours Worked

5.

Rename Sheet 3 to Sales

Changing the Tab Colour
To change the colour of a worksheet tab:
1.
Right click on the tab name at the bottom of the screen
2.

From the pop-up menu, click Tab Colour

3.

Select a new colour from the list

Deleting Sheets
To delete a worksheet:
1.
Right click on the tab name at the bottom of the screen
2.

From the pop-up menu, click Delete

Inserting New Sheets
To insert a new worksheet:
1.
Right click on any tab at the bottom of the screen
2.

From the pop-up menu, click Insert
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3.

In the Insert window, select Worksheet and click OK

Copying a Sheet
To make a new copy of an existing worksheet:
1.
Right click on the tab name you want to copy at the bottom of the screen
2.

From the pop-up menu, click Move or Copy

3.
The Move or Copy window will open. Select where you want the copied worksheet
to be inserted.
4.

Click on the Create a copy tick box and click OK
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Charts
You can easily convert data from a table into a chart. This is useful for presentations or
reports.
1.
Create a new worksheet in your workbook and name it Chart Data
2.
Create this spreadsheet:

3.
Select the cell range to turn into a chart. Click and drag your mouse cursor to
select cells A3 to B7.
4.

In the Insert Ribbon Click on the Pie button and select a 2D Pie

You can change the title of your graph and any other labels. Try clicking on various
elements, or using the options in the Chart Format menu.
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Saving Your Workbook
1.

From the File menu, select Save As, then select Browse.

2.
The Save As window will open. Select where you would like to save your
worksheet and give it a file name

3.

Click Save
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Where to from here?
Well done on completing the Basic Computer Skills class! Hopefully you have learnt new
skills and feel ready to keep practising and improving your computer skills.

Internet and Computer Access
Brimbank library members can use computers with internet access at no charge. There is
a limit of one hour per day of computer use for each library member.
Wireless internet access is also available at no charge and with no time limits.

Computer Classes
There are many other classes you might be interested in joining to broaden your
computer knowledge and skills.
Basic Classes
Basic Computer Skills
Basic Internet
Introductory Specialist Classes
Introduction to eBay
Introduction to Email
Introduction to Excel
Introduction to Photoshop
Introduction to PowerPoint
Introduction to Web Design
Drop In Resume Help
Open to anyone wanting basic advice and helpful tips on how to present their resume.
Bring in your current resume for formatting tips, assistance with saving it for future
editing, adding as an attachment to an email or uploading to a job seeking website.
St Albans: Tuesdays, 2pm - 4pm
Cyber Seniors Computer Group
For seniors interested in learning more about computers and computer applications in a
friendly and informal setting. A basic understanding of how to use a computer is
required.
Sunshine: Last Monday of the month, 11am - 12noon
Sydenham: Last Wednesday of the month, 11:30am – 12:30noon
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The Class

Excellent

Good

Needs improvement

Excellent

Good

Needs improvement

Venue and training space
Take home manual
Equipment
Length of class
Content of class

The Trainer
Knowledge of subject
Style and presentation
Teaching skills
Friendly and helpful

Which days and times of the week suit you best for classes?
Mon

Tue

Wed

Thu

Fri

Sat

Morning
Afternoon
Evening
What other training are you interested in?
Would you attend another computer class?
If you answered “No”, why?

Yes

No

Any other comments?

How did you find out about this class?
Library brochure/flyer
Library staff
Library website
Friends/family
Council customer service centre
Community Wellbeing Guide
Community centre
Other:
Which Brimbank Library do you visit most?
Deer Park
Keilor Village
St Albans

Sunshine

Your postcode:
Staff use - Date:
Location:
Deer Park
Trainer’s Name:

Keilor

St Albans

Sunshine
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Sydenham

